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General use
Version

Save

VELUX Energy and Indoor Climate Visualizer
is available in two versions, a standard and a
pro version. The standard version gives access
to a range of pre-defined typical geometries,
whereas the pro version gives you the
possibility of changing the size of a generic
building or to import geometry from various file
formats. For more information about the two
versions, see: http://eic.velux.com.

You can save the current case by selecting
Save from the File menu. You can also choose
Save as… to save into a new file.

The version type can be found by selecting
About EIC Visualizer from the Help menu. It
will say 'Pro' or nothing.

Open
Choose Open from the File menu to open an
old case. Browse to the folder of your case and
select the file. Finally click the Open button.
The most recent opened cases will be
available in the File menu.

Help and support
Pressing F1 or choosing Help will open the
User guide. The user guide will be opened
automatically in the section corresponding to
the tab, which is active when F1 is pressed.
The About dialogue box contains information
about tool version and contact information
about the VELUX EIC Visualizer team.
For further technical information, download the
technical background document on the
website.

Automatic check for updates
When the EIC Visualizer starts, it automatically
checks if an updated version is available from
the EIC Visualizer server via the internet. If an
update is available, the user is asked if the
update should be downloaded and installed.
Figure 1 About dialogue box

Starting a new case
A new case is created when you select New
from the File menu. Several cases can be
open at the same time. The open case
windows are managed from the Window menu.

The use of a firewall might conflict with the
automatic update function. Please contact your
local network responsible for further details.

Keyboard shortcuts
Ctrl
Ctrl
Ctrl
Ctrl

+
+
+
+

s:
o:
n:
F4:

Save current file
Open a project
New project
Close current project
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Geometry
This tab is active when a case is opened. Here
the geometry and location of the building are
specified. All input data fields have default
values. When you change a value, the 3D
model is updated accordingly.
The colours are default and do not represent
specific construction materials used. The 3D
model shows a simple representation of
window insertions. For roof windows, the
calculations are based on installation principles
and lining configurations as recommended by
the VELUX Group.

Building geometry (standard)
Note: In the pro version, click Simple Geometry to change
to the fixed geometries.

Geometry: Select one of the default house
types:
1-storey single-family house with sloped ceiling
1-storey single-family house with flat ceiling
1½-storey single-family house
Roof space on apartment building

End wall configuration: Select whether the
house is free-standing or part of a row of
buildings. A house in a row will use less energy
than a free-standing house, because no
energy is lost through the walls that connects
to the rest of the building.
If the building is defined as a row house or an
attic, the neighbouring or underlying building
will be presented by a transparent, grey shape.
Size: For each house, one of three default
sizes can be selected. Internal measures are
used, i.e. internal distances between walls.
You should choose the building geometry,
which is closest to that of the actual building
you are evaluating. An irregular, e.g. L-shaped
building can be evaluated by selecting the
rectangular EIC Visualizer model
representation. The building size with an area
closest to the specific design should be
selected. Remember to take into consideration
the location of the windows in the building
(north/south/east/west). The simulator will
produce results, which are well-suited for
comparing one case with another, i.e. the
addition of a window, even if there are

Figure 2 Geometry tab from standard version
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differences between the geometry of the EIC
Visualizer model and the actual building's
geometry (as long as they have a comparable
net area).
Note: For more information about the fixed geometry of
the building you can go to Geometry in Appendix

Alternatively, you can visit http://eic.velux.com
and see how to get the pro version of the
program, where it is possible to change the
size of the generic models and import building
geometry from various file formats.

Figure 3 Measurements

Building geometry (pro
version)

The internal floor area is automatically
calculated from the volume of the building. If a
value is manually typed in, this value will
override the calculated value.

Generic model

Imported model

Change the size of the generic model with the
input boxes. Always state internal measures as
shown in Figure .

To import a model, select the Import 3D model
radio button and click the Import geometry
button. In the dialogue box, browse to your
geometry file and click open.

The ceiling can be either sloped or flat. If flat
ceiling is chosen, the roof windows will be
modelled with light shafts with the same
construction as the roof.

The EIC Viz currently supports 3D Studio Max
(3ds), AutoCAD 200X (dwg and dxf), Google
SketchUp (skp), OBJ (obj) and VELUX
Daylight Visualizer 2.5 exports (exp). See the

Figure 4 Geometry from the pro version
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3D guidelines on http://eic.velux.com for more
details on how to create 3D models.
Building location
Location: Choose the geographic location of
the building. The list contains major cities from
around the world and the most relevant city
should be selected.

energy balance in the building by means of
roller shutters and awning blinds. It will activate
the sunscreening products in the daytime
during summer and at night during the winter.
This reduces the need for cooling in the
summer time and the need for heating in the
winter time. The Energy Balance program is
particularly relevant in warm climates.

Orientation: Choose the orientation of the
building. Major orientations can be selected
from the list. The orientation is indicated by the
compass in the 3D model.
If another orientation is needed, this can be
made by choosing Degrees from north and
typing the relevant orientation towards east.
Country: The country selection affects the
currency used in the reports, energy price and
the data sheet with pre-defined times for the
program Energy Balance for controlling the
sunscreening products.
The selection of country can be changed by
pressing Country in the Building location box.
This opens the Country dialogue box as seen
in Figure 3. Data about currency and energy
price for the selected country is specified here.
In this dialogue box, it is also possible to adjust
the values in the program Energy Balance. It is
possible to select the city that is geographically
closest to the location of the building in order
to optimise the effect of the program. The
program Energy Balance is compatible with
io-homecontrol® roller shutters and awning
blinds. The program provides an optimised

Figure 3 Country dialogue box

The program is defined for major cities, and
the city closest to the actual location of the
building should be selected. If no relevant city
is available, select "None".
It is possible to enter a new country name,
which will appear in the list of countries. This is
done with the Save as… button. The country
name will be saved with the current project,
and will only be available within the current
project.
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Constructions
Here the different construction types of
external walls, roof and floor are specified.
When you change a value, the 3D model is
updated to reflect the thickness of the selected
construction type if the feature wall thickness is
turned on.
Building envelope
Any construction can be assigned to one of the
four construction types. Click on the desired
construction to select it and choose the
relevant construction type from the radio
buttons.
Note: The lowest horizontal construction will automatically
be assigned as floor, vertical constructions as walls and
sloped constructions as roof.

External wall construction: The wall
construction of the house is selected from the
items in the list.
Roof construction: The roof construction of
the house is selected from the items in the list.
External floor construction: The external
floor construction of the house is selected from
the items in the list. This is the floor at the
lower boundary of the house.

Adiabatic: The adiabatic construction type is
used to represent a construction facing a
heated room, for instance the walls dividing a
row house. It is assumed that there will be no
heat loss through an adiabatic construction.
Leakiness: The leakiness of the house is
selected from the items in the list. Choose the
construction period, which is most
representative for the project.
Note: You can find more information about Leakiness
under Constructions in Appendix

Editing walls, roofs and floors
It is possible to edit the definition of walls, roof
and floor. This is done by clicking the blue,
underlined titles. Clicking a link opens a
dialogue box as shown in Figure 5. In most
situations, the standard construction items will
be sufficient.
The U-value and thickness of the construction
are shown, as well as each individual layer of
the construction. It is possible to change the
thickness of each layer. When a value is
changed, the U-value and thickness of the
construction are updated accordingly.

Figure 4 Constructions tab
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It is also possible to change or add materials.
Materials can be selected from the library of
construction materials.

Editing material properties
Material properties can be edited. This will only
be necessary in rare cases. The Material
dialogue box is accessed from the dialogue
box for editing construction types.

Figure 6 Dialogue box for editing construction materials
Figure 5 Dialogue box for editing walls, roofs or floors

The changed construction can be saved as a
new construction type. The new construction
will be saved in the current project, and will not
be available for other projects.

The heat conductivity, density and specific
heat capacity of the material can be edited.
The material can be assigned to a category.
Note: Under Constructions in Appendix you can find more
information about advanced material properties settings
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Windows and doors

Figure 7 Windows and doors tab

At this tab, windows, doors and openings are
added and edited. When you add or change a
value, the 3D model is updated to reflect the
change and show the window, door or
opening.

the 3D view. It is possible to change the
properties at any time.

To add a new window, door or opening, press
the "Add new window/door" button. Then the
settings of the element are selected. Finally,
press the "Place" button. The new window,
door or opening can then be placed in the
model using the mouse. There is a visible 0.5
m x 0.5 m grid which the window snaps into.

Window/door

The windows, doors and openings installed in
the house can be duplicated using the 3D
view. A window is selected by clicking on it.
The selected window/door is shown in blue
and the coordinate system of the wall is shown
in green and red colours. To copy the window,
press the button "Add new window/door"
followed by pressing the "Place" button.
When a window is selected, the properties of
the window are shown in the fields to the left of

It is not possible to select more than one
window at the time.

Type of window or door: You can select a
roof window/extract duct or a façade window,
door or façade grill.
Window/Door: The type of window, door or
opening is selected.
Façade windows can be openable or fixed.
Façade windows can have a ventilation flap (or
grill) built into the frame.
It is possible to define your own window type.
Choose "Custom window/roof window" from
the drop-down menu under Window/door.
Window/door becomes clickable, which will
open a dialogue box where the properties can
be edited.
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Custom façade window/roof window
The following values should be entered: U-value of the
frame (Uf), the widths of the frames and the linear
transmission loss (Psi) between window and roof. For roof
windows the maximum opening area and effective height
can also be edited. See the technical background
document for more details on how this is done.
Note: In the Appendix, under Windows and doors you can
find more detailed information about custom settings

Size: The size of window, door or opening is
selected or typed in.
Pane: The type of pane for the window or door
is selected.
It is possible to define the type of pane by
choosing "Custom pane" in the drop-down
menu under Pane. Pane becomes clickable,
which will open a dialogue box where the
properties can be edited.
The following values should be entered: g-value, tv, te, psi
and U-value of the glazing. The U-value is needed for
three slopes: 0°, 45° and 90°. Values in between are
interpolated from these. If accessories are to be used, Fc,
Ft, dUg of the products are needed. See more details on
this in the technical background document.
Note: For more information about abovementioned
parameters go to Windows and doors in Appendix

Accessories: If the window is installed with
sunscreening products, select the products
from the list.
Openable for natural ventilation: By
selecting this option, it is defined which
windows will be used for natural ventilation.
All selected windows will be controlled with the
same control options; it is not possible to select
different control options for different windows.
Place: When the "Place" button is pressed,
the mouse can be used to decide where the
window should be placed on the roof or
façade.

Remove: The "Remove" button is used to
delete the selected window/door.
Exact location: The exact coordinates of the
selected window are shown in the boxes. The
location can be changed by changing the
coordinates if the window cannot be dragged
with the mouse to the desired location. The
coordinates are relative to the surface where
the window is installed.
Include natural ventilation extract
duct or façade grill
It is possible to add natural ventilation extract
ducts or façade grills. These can be selected
from the Window/door drop-down menu and
can be placed and edited in the same way as
windows and doors. The duct or grill will be
open constantly. The airflow through ducts will
depend on the diameter and height above roof
ridge. The airflow through a façade grill
depends on its width and height. Also on the
leakiness of the house and the distribution and
control of windows for natural ventilation have
an influence.
Natural ventilation extract ducts and façade
grills are common in bathrooms and kitchens.
Extract duct
Diameter: The diameter of the duct.
Height above roof ridge: The distance from
the roof ridge to the top of the duct. The lower
end of the duct starts at the underside of the
ceiling. The length of the duct is from the
underside of the ceiling to the top of the duct.
Façade grill
Width and height: The dimensions of the free
opening area of the grill. This area is less than
the actual hole in the wall and is the total area
minus the area of the physical grill.

Figure 8 A green rectangle indicates a location where the window can be placed. The red "no-drop" cursor indicates a window
location, which is not valid.
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Heating and cooling
At this tab, the controls for heating, cooling and
sunscreening are selected as well as the
schedule for the occupants of the house.

People
Number of people: The number of people
occupying the house is selected.
Schedule: State when the occupants will be in
the house by choosing the schedule, which
best describes their occupancy of the house.
The schedule can be edited by pressing
Schedule.
In the Schedule dialogue box, the blue line represents the
occupancy of the house. 1.0 means that all occupants are
in the house. If nobody is in the house, the graph should
be 0.0. It can be 0.5 if half of the occupants in the house
are at home.
The blue line is edited directly in the diagram by clicking
and dragging parts of the line. The schedules for
weekdays and weekends can be different depending on
the check box selections.
Note: Under Heating and Cooling in the Appendix you can
find information about advanced Schedule settings

Figure 9 Dialogue box for editing occupancy schedule

Heating and cooling system
Heating set point: The set point for the
heating system. The heating system will
attempt to maintain the specified indoor air
temperature.
Note: The systems will use the indoor air temperature as
set point. The results will show the operative temperature
which can be a bit different. For further explanation, see
the DEIC Book.

Figure 12 Heating and cooling tab
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Preferred max. summer temperature: This
input has two purposes and must always be
specified:
If a cooling system is present in the house, this
temperature is the set point for the cooling
system. The cooling system will then attempt
to maintain the specified indoor air
temperature.

Advanced options
By pressing this button, you can choose
various options for electrical equipment,
heating and cooling.

The temperature is also used for the night
cooling control of natural ventilation.
Cooling system present: If "yes" is selected,
a cooling system (air conditioner) is installed in
the house.
Internal and external sunscreening
On when indoor temperature is above ___
°C: If this control is activated, the sunscreening
products are activated when the indoor air
temperature is above the set point and
deactivated when the indoor air temperature is
below the set point.
Automatic roof window control: These
features only apply to roof windows and will
override the temperature control if active.
VELUX ACTIVE climate control (sensor
based): If this control is activated, the
sunscsreening products are controlled by
sensors on the window.
The VELUX ACTIVE climate control feature is
available for all external and internal iohomecontrol® sunscreening products.
The automatic operation is based on an
algorithm that optimises the use of
sunscreening products throughout the year.
The algorithm is based on input from two
wireless exterior sensors that measure the
outdoor air temperature and the solar radiation
on the roof windows.
VELUX Energy Balance (time controlled):
The Energy Balance program is available with
all io-homecontrol® roller shutters and awning
blinds. It automatically controls the exterior
sunscreening products to help optimise the
energy balance of the building. It will activate
the sunscreening products in the daytime
during summer and at night in the winter. This
reduces the need for cooling in the summer
and the need for heating in the winter. The
Energy Balance program is particularly
relevant in warm climates. The time schedule
is controlled by the country selection and can
be changed in the Country dialogue box.

Figure 13 Pressing the Advanced options buttons opens
more options

Electrical equipment
Internal gains (electrical appliances): The
internal gains are the electricity used by
appliances, which are not part of the energy
calculation. These are kitchen appliances,
electronics, etc. The internal gains are not
included in the energy demand of the building,
but they are considered a "free gain", which
will reduce the heating demand of the building.
Increasing the internal gains will reduce the
heating demand of the building.
It is difficult to make a precise estimate of the
internal gains, but a value between 2 and 5
W/m² will often be reasonable depending on
the number of occupants.
Schedule: The schedule for the gains can be
edited if they are not the same during the day.
They are edited as described in the paragraph
People.
Heating system
Energy source: The energy source for the
heating system is selected here. These options
are used to calculate the results of energy
costs. The energy source can be edited by
pressing Energy source.
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Electrical Lighting
Type of electrical lighting: the type of
electrical lighting is selected here. You have
the choice between Typical, Incandescent and
Fluorescent light source with the setpoint of
25, 50 or 100 lux. By clicking on “type of
electrical lighting” you can adjust values of
specific artificial lighting system’s parameters.
Note: You can find more information about Electrical
lighting system setting in the Appendix.
Figure 14 Energy source dialogue box

Efficiency of heating system: The
efficiency of the heating system has an
influence on the amount of fuel used. An
electrical heating system is approximately
100% effective. The efficiency of an oilburning boiler is lower, e.g. 70%.
Energy price per kWh (heating value of
fuels): The energy price should be per kWh.
Cooling system
COP, coefficient of performance: The
COP of the cooling system should be
inserted. A typical unit could have a value of
2.0 to 4.0. The higher COP value the better
performance.

Figure 15 Electric lighting settings

13/40

Ventilation
In this tab, the controls for ventilation are
selected. The windows, which have been
marked as "openable for natural ventilation" on
the Windows and doors tab, will be used with
the controls below.

Control of overheating
These controls can be used to control
overheating via opening the windows.
Open windows when the indoor
temperature is above ___ °C: Façade and
roof windows are opened when the
temperature is higher than the desired indoor
temperature. The specified temperature will be
used as a set point so that the windows will
start opening 1-2°C before the set point is
reached.
This function will only be activated when the
occupants are present in the house, and if the

the building from being heated further if the
outdoor temperature is higher than the indoor
temperature, thus preventing further
overheating.
Use windows for night cooling: All openable
roof windows open between 22:00 and 7:00 if
the indoor temperature at 22:00 is above the
average of the heating set point and the
preferred maximum summer temperature, and
if the outdoor temperature is below the desired
indoor temperature. This function is relevant in
warm climates to cool the building during the
night and use the thermal mass as a buffer.

Control of air quality
Demand controlled ventilation based
on CO2 level
This is a CO2 based demand control of the
indoor air quality. The ventilation system will be

Figure 16 Light and ventilation tab

outdoor temperature is less than 2°C above
the desired indoor temperature. This prevents

used to maintain the comfort category chosen
in the set point dropdown, see Table 1 for
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details on the used levels. Custom levels can
be used. Select Custom in the drop-down
menu and click the link Set point to edit the
values.

house. This function can be used to refresh the
air in the house and is recommended in cold
climates to reduce humidity problems.
The temperature set point can be used if
ventilation is considered undesirable on very
cold days.
Use window ventilation flaps for
background ventilation when outdoor
temperature is above ___ °C
With this function, the ventilation flaps of all
windows with ventilation flaps (not only those
marked as "openable") are kept open all year
to supply background ventilation. It is
recommended to use this feature to provide a
healthy indoor environment. The temperature
set point can be used if background ventilation
is considered undesirable on very cold days.
Mechanical ventilation

Figure 17 Max CO2 level specification
Table 1 CO2 levels by indoor air quality categories

CO2-level [ppm]
Category I
Category II
Category III

Maximum
750
900
1200

Minimum
500
650
800

If a mechanical ventilation system is active, the
air change rate will be adjusted to maintain the
maximum level. If natural ventilation is active,
the windows will open fully when the maximum
level is reached and close again when the
concentration drops and the minimum level is
reached.

If this option is ticked off, mechanical
ventilation is considered active according to
the schedule.
Details about the mechanical ventilation
system are found in the advanced options
section.

Advanced options
By pressing this button, you can choose
various options for the ventilation systems.

The ventilation system is controlled with the
radio buttons: Natural ventilation all year,
Mechanical ventilation all year or Hybrid
ventilation. The hybrid solution settings is
changed under the advanced settings, see
below.
Manual control
Three different controls can be used for
manual airing the building.

Figure 18 Advanced options in the Ventilation tab

Use windows for airing when outdoor
temperature is above ___ °C

Constant ventilation rate

All windows are opened in the selected
intervals of the schedule. Roof windows are
opened approx. 21 cm (corresponding to the
max. opening of an electrically operated
INTEGRA® roof window). Façade windows with
a window height above 1.5 m will open 10%
and façade windows with a window height
below 1.5 m will open 20%. The house will only
be aired when occupants are present in the

The ventilation rate will be kept at the user’s
specified level all year regardless of wind
conditions, pressure differences and more.
Windows will not be opened.
Note This is an unrealistic ventilation option and should
only be used for special cases. For instance if required by
local building legislation.
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Ventilation settings
Mechanical ventilation system
Choose one of the predefined ventilation
systems from the drop-down menu. To view or
edit the settings press Mechanical ventilation
system.

-

Ventilation type
The system types are: Balanced
ventilation with heat recovery,
balanced ventilation with no heat
recovery, extract ventilation with no
heat recovery.

Hybrid ventilation settings
Choose one of the predefined settings from the
drop-down menu. To change the settings,
press Hybrid ventilation settings.
The settings control when to switch between
the two ventilation systems.

Figure 19 Settings for mechanical ventilation system

A manual control schedule can be chosen from
the drop-down menu and edited as described
in the heating and cooling section. An
automatic control algorithm can be used. The
system uses a set point to determine which
system to use. If the outdoor temperature is
higher than the set point, natural ventilation will
be used and vice versa.

Settings that can be changed are:
-

Specific fan power (SFP) in W/(m³s)
The SFP tells how much energy is
used by the ventilation system. The
higher the number the more energy is
used.

-

Heat recovery efficiency
The heat recovery efficiency tells how
much heat that can be recovered. The
higher the value the more energy for
heating is saved

16/40

Start simulation

Figure 20 Start simulation tab

At this tab, the project is described and the
simulation is started, and additional results can
be selected to be included in the output.

This button opens the Description dialogue box
where information about the project can be
entered. The information will be included in the
results report.

Note: Changes to the description will not be updated in the
reports before a simulation has been run.

By pressing this button, you will see the
available advanced results, which can be
logged during the simulation. The options
selected here have no influence on the results
report. The options only have an influence on
which advanced results will be available after
the simulation for analysis by experienced
users.
All options can be selected, but some of the
options will generate large data files (more
than 100 MB).
Press the "Start simulation" button to start the
simulation.

Figure 21 Description dialogue box

If more than one model is to be simulated,
press the "Simulate all open models" button.
Pressing this button will start the simulation of
all models which are open in the program, one
after another.
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If you want the results to be displayed in a form
of animation after the simulation process is
over, click the “Start data collection” button.
Pressing this button will open the simulation
progress window.

Before starting the collection of data, you can
adjust settings for the simulation, by simply
pressing the “Settings” button.
On the upper part of the window it is possible
to precise the “Detail level” of the simulation,
which includes such parameters as “Layer
height”, “Grid resolution”, “Time resolution” and
“Limits”. By default, there are three levels of
details from the lowest to the highest:
“Coarse”, “Medium” and “Fine”. You can also
type your own values for certain parameters.

While the simulation is running, a simulation
progress window will be visible. The date at the
top-right corner shows the progress during the
year. During the simulation, the indoor and
outdoor temperatures are shown on a scale
from -10°C to +30°C and the ventilation rate of
the building is shown on a scale from 0 to 5
ACH. This view can be used to tell if the
building and controls act as expected.
A simulation can be paused by clicking the
Stop button. To continue click Resume and to
terminate the simulation click Abort. If aborted,
reports and animations cannot be made. Only
the advanced results are available.

In the bottom part of the window you can
precise the range of time for the simulation.
Clicking on the calendar icons on the right side
it is possible to choose its starting and ending
date. You can also type the exact hours. Note
that you will only be able to animate results in
the specified time range.

Figure 23 Simulation progress window

Figure 22 Start simulation tab
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Results

Figure 24 Results tab

At this tab, results are selected and viewed.
Generate report
The results reports are printable reports, which
contain the main results of the simulation. The
reports cover the needs of most users. The
contents can be customised.

By pressing this button, a report is generated
with results of the model.
In the top right corner, a menu is shown, The
additional results in the menu can be turned on
and off. The menu can be hidden if it interferes
with the content.
The report is an HTML file, which can be
printed and saved from the file menu. The
"Save" function will only save the text and not
the diagrams, so it is recommended to use a
PDF conversion utility tool. Choose "Print" from
the file menu, and select a pdf printer. See
report help for more information.
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By pressing this button, a report which
compares the results of all the models which
are open in the EIC Visualizer is created.
Several models can be open at the same time
and this function is used to compare variants
of the same building, e.g. a basic project and a
project with additional windows or
sunscreening products.

When this button is activated, it is possible to
create an animation of results obtained from
the simulation. There are two types of
animation – colour animation and arrow
animation, differing with the form of visual
results presentation.

The report can be changed, printed and saved
according to the same principles as the single
report.

When this button is pressed, it is possible to
animate the operative temperature and
compare it to the comfort range and other
simulation results. Each open project will be
compared to the active project.
The comfort range is based on the active
project and is calculated on the basis of the
outdoor temperature, according to the
European Standard EN15251. The outdoor
temperature is also shown.
Note: If models with different climatic conditions or models
with and without mechanical cooling are compared, the
comfort ranges of the active project is shown. The comfort
range is based on the outdoor temperature and the
presence of a cooling system.

Figure 26 Animation window

Color animation

Figure 25 Comfort temperatures

The graph shows the temperatures and
comfort range for either one day or one week.
Under advanced results, the comfort range
(class I, II and III) and outdoor temperature
together with the operative temperature of the
open projects can be seen for the entire year.

In the colour animation type the results are
represented by colors, according to the scale
of values, present on the left side of the 3D
model window. You can influence the scale
range by specifying the minimum and
maximum value for particular parameter.
In the 3D view of the model, you can see the
results as a volume, filling the interior of the
building or moving across it. The volume
represents all the values of the animated
parameter in the specified range. In order to
see specific values in a certain part of the
building and their changes in time you have to
go to the horizontal section view. Setting the
section plain height to about 1 m allows you to
see the animated changes of parameters’
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values on the approximate height of person’s
activity.
Air temperature
The air temperature for the current time step is
represented by colors in Celsius Degrees
according to the scale of values. In the
horizontal section view, on the section pane
you can observe how it varies, depending e.g.
on the airflows entering the building through
the openable windows. On the animation it can
be clearly observed how time of the day (and
accordingly position of the sun), direction and
velocity of the wind etc. influence the air
temperature.

Mean radiant temperature
The mean radiant temperature for the current
time step is represented by colors in Celsius
Degrees according to the scale of values. The
mean radiant temperature (MRT) is defined as
the uniform temperature of an imaginary
enclosure in which the radiant heat transfer
from the human body is equal to the radiant
heat transfer in the actual non-uniform
enclosure.
Displaying the mean radiant temperature
animation on the horizontal section pane, you
can observe how the parameters changes in
time, how is it influenced by the position of
windows and other factors.

Figure 27 Air temperature animation

Air velocity

Operative temperature

Air velocity in m/s can also be displayed in a
form of color animation. On the horizontal
section view of the model you can observe
where the air movement occurs in the building
for a current time step, what is its direction and
the value of air velocity according to the
specified range of values. If in the design there
are windows openable for natural ventilation
implemented, it is clearly visible how they are
causing the air movement. Its velocity is
obviously dependent on the time of the day,
wind properties etc.

Another indicator of indoor thermal control that
can be displayed in a form of animation is
operative temperature. Operative temperature
is defined as a uniform temperature of an
imaginary black enclosure in which an
occupant would exchange the same amount of
heat by radiation plus convection as in the
actual non uniform environment. It is derived
from air temperature, mean radiant
temperature and air speed.
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Operative temperature animation should also
be displayed on the horizontal section pane. It
can be then easily observed how does the
parameter change and what factors is it
influenced by.
Predicted percentage of dissatisfied
Another indicator of thermal comfort in the
building that can be represented as a color
animation in VELUX Energy and Indoor
Climate Visualizer is Predicted Percentage of
Dissatisfied. PPD predicts the percentage of
occupants that will be dissatisfied with the
thermal conditions. The unit for the parameter
is % - as the name indicates, and therefore the
range of its values should always be 0 – 100 %
(from 0 % to 100% persons dissatisfied with
the indoor climate). As it is not possible to
please all of the people all of the time, the
recommended acceptable PPD range for
thermal comfort from ASHRAE 55 is less than
10% persons dissatisfied for an interior space.
Displaying the animation on a horizontal plane
set to the height of the person activity (about 1
m) you can observe how the PPD indicator
changes during the day in the particular parts
of the building.
Predicted mean vote

Arrow animation
In this type of animation, you can see the
results represented by the arrows. The window
air flow and current window energy balance
parameters’ values are indicated by arrows’
size, colour and shape.
Ventilation flows
Arrows show the flow through the individual
windows. The size and colour of the arrow
represents the magnitude of the airflow in l/s
according to the scale.
There can be two airflows through each
window. This represents how pivoting roof
windows work, but also applies to other types
of windows. The airflow can enter through the
window in the same direction at the lower and
upper part of the window, but can also have
opposite directions.
The airflows take into consideration that there
is infiltration in the building (air entering the
building through leakages in the façade and
connections between construction
compenents). Due to the stack effect, it is
common that air will enter the house through
façade windows and be extracted through roof
windows.

Predicted Mean Vote is another thermal
comfort indicator that can be displayed in a
form of color animation. The PMV index
predicts the mean response of a larger group
of people according the ASHRAE thermal
sensation scale:

+3 hot
+2 warm
+1 slightly warm
0 neutral
-1 slightly cool
-2 cool
-3 cold
In the animation settings, the range of PMV
values should follow the ASHEAE scale with
the minimum value of parameter -3 and
maximum 3. The optimal value, assuring good
quality of thermal comfort in building is 0 –
neutral.
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Figure 28 Window air flows animation

Current window energy balance
Arrows show the energy flow in and out of the
individual windows for the current time step.
The size and the colour represent the
magnitude of the energy flow according to the
scale. The arrow with two arrow heads shows
the solar gain and the arrow with one arrow
head show the transmission loss. The
transmission loss can be in both directions but
not at the same time.

animation period, but this can be much higher
than the typical values. It will often be helpful
to reduce the maximum value to 50 l/s or less
for ventilation. For the current energy balance
animation, the maximum value should be
adjusted according to the season in question.
Show advanced results
In this view, experienced users can select
detailed results to analyse specific issues.

Note Current window energy balance should not be
compared with energy balance equations for a whole year.

Animation settings
It is possible to change the start and end time
of the simulation. This can be used to
investigate a typical summer, winter or spring
day, for example. The animation speed can
also be adjusted. The higher the number in
hours per second, the faster the animation will
run.
Scale bar: Max.: This option can be used to
adjust the scale of the arrows. The maximum
value is automatically assigned to the highest
airflow or energy flow occurring during the

Figure 29 Advanced results of the animation
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each window there is a column titled QSOLAR
and a column titled QTRANSM. QSOLAR is
the heat gain, and QTRANSM is the
transmission. QTRANSM will be negative
during the winter season. On warm summer
days, it can be positive when the outdoor
temperature is higher than the indoor
temperature.

Figure 30 List of the advanced results

Each advanced result will open a diagram.
This can be changed to a table view using the
tabs at the top of the results window.

Data can be exported directly to Excel via the
logo at the bottom right corner. The standard
exported values uses the time steps used in
the calculations. To get hourly values, use the
table pane and change the table properties to
hourly values. Then copy the data manually
into Excel. This method will export the hourly
mean values of the preceding hour. More
details on this issue are found in the technical
background document.

The arrows at the bottom of the results window
can be used to change from annual to for
example monthly results.
The energy balance for each window in a
project can be found in "Energy performance
of building – including individual windows". For

Figure 31 Time step settings

Figure 32 Advanced results
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Using the 3D view

Figure 33 3D view

The geometry of the building is shown in the
3D view to the right with solid walls showing
the wall construction. A compass is shown to
keep track of the orientation of the building.
The 3D model can be interactively rotated,
zoomed and panned.

z+: Cut 3D model along the z-axis removing all
geometry on the positive side of the cut plane.

Descriptions of buttons:

Select object: Click left mouse button to select
an object. The selected object is shown in
blue.

Turn on/off thickness: This button will turn on
or off the thickness of the constructions, see
Error! Reference source not found..
Restore default view: This button resets the
section view and displays the full building.
x+: Cut 3D model along the x-axis removing all
geometry on the positive side of the cut plane.
x-: Cut 3D model along the x-axis removing all
geometry on the negative side of the cut plane.
y+: Cut 3D model along the y-axis removing all
geometry on the positive side of the cut plane.
y-: Cut 3D model along the y-axis removing all
geometry on the negative side of the cut plane.

z-: Cut 3D model along the z-axis removing all
geometry on the negative side of the cut plane.
Description of mouse operations:

Move and rotate the model: Hold down left
mouse button to move and rotate the model.
The model is always oriented so that the
positive z-axis is upwards.
Cut: Hold down left mouse button and press
Ctrl-key. Click within red frame, hold down and
move mouse. Move the cut plane.
Move the model up, down, right or left: Click
middle mouse button (or both the left and the
right mouse buttons on a two-button mouse).
Hold down and move the model around.
Open right mouse button menu: Click right
mouse button.
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Zoom in/zoom out: Hold down right mouse
button and move the mouse. Move the mouse
upwards to zoom in and downwards to zoom
out.

Zoom extends: Click right mouse button
menu: Zoom and pan the model so that the
entire model is visible (Hotkey R).

Set focus:
Click right
mouse button
menu: Set the
point around
which the
model is
rotated and
towards which
it is zoomed
(Hotkey F).
Figure 34 Turn off/on thickness
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Appendix
Geometry

Figure 35 Geometry tab

The house volumes are based on internal
areas. For the 1-storey house, the floor area is
simply the width myltiplied by the length of the
house.

For the 1½-storey house and the roof top
apartment, the floor area is only counted for
the part of the floor, where the height from floor
to ceiling is 1,5 m or higher. The floor area,
height and volume of each house type are
found in the tables below.

Table 2 Dimensions of 1-storey house with flat ceiling

1-storey house, flat ceiling
Internal width
Internal length
Internal floor height
Internal floor area
Internal volume

A
7m
14 m
2,5 m
98 m²
245 m³

B
8m
18 m
2,5 m
144 m²
360 m³

C
8m
22 m
2,5 m
176 m²
440 m³
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Table 3 Dimensions of 1-storey house with an open ceiling

1-storey house, open ceiling
Internal width
Internal length
Internal floor height
Internal floor area
Internal volume

A
7m
14 m
2,5 m
98 m²
325 m³

B
8m
18 m
2,5 m
144 m²
494 m³

C
8m
22 m
2,5 m
176 m²
604 m³

A
7,5 m
8,0 m
2,5 m
0,8 m
60 m²
49 m²
109 m²
311 m³

B
8,0 m
10,0 m
2,5 m
0,8 m
80 m²
66 m²
146 m²
424 m³

C
8,0 m
12,0 m
2,5 m
0,8 m
96 m²
79 m²
175 m²
509 m³

A
11,0 m
7,0 m
0,8 m
6,3 m
67 m²
28 m²
95 m²
273 m³

B
11,5 m
9,0 m
0,8 m
6,6 m
91 m²
41 m²
131 m²
380 m³

C
12,0 m
11,0 m
0,8 m
6,8 m
117 m²
55 m²
172 m²
502 m³

Table 4 Dimensions of 1½-storey single family house

1½-storey single family house
Internal width
Internal length
Ground floor height, internal
First floor height, internal
Ground floor area, internal
First floor area, internal
Total floor area, internal
Internal volume
Table 5 Dimensions of a house with an roof space

Roof space (on top of building)
Internal width
Internal length
Internal floor height
Internal height from floor to roof top
Ground floor area, internal
First floor area, internal
Total floor area, internal
Internal volume

When using the row house type, the walls to
neighbouring buildings are considered
adiabatic in the simulation. The wall type for
the adiabatic walls cannot be edited; it is fixed
as a heavy wall construction with a U-value of
0,29 W/m²K.
The floor of the roof top apartment house type
is adiabatic. It cannot be edited and is a light

floor construction with a U-value of 0,76
W/m²K.
The climate data files used in the EIC
Visualizer are the ASHRAE climate data files
published at
http://apps1.eere.energy.gov/buildings/energyp
lus/cfm/weather_data.cfm.
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Constructions

Figure 36 Constructions tab

The properties of each construction type can
be seen by clicking the construction type (blue
text and underlined). This opens the
Construction definition dialog, where the Uvalue and thickness of the construction are
seen. It is also seen which materials are used
in the construction and the thickness of each
material can be changed.
Material properties can be seen and edited by
clicking the Material (blue text and underlined)
under Layer data. This opens the Material
dialog.

Click to edit
material
properties

Figure 37 Constructions tab
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Figure 38 Constructions tab

At the Material dialog, the properties of each
material can be seen and edited.
U-values
The U-values seen on the Constructions tab
are based on fixed surface resistance
coefficients. This means that the U-values
seen here are an approximation of the actual
U-values used in the simulation. In the
simulations, surface resistance coefficients are
not fixed numbers, but vary continuously
depending on temperature differences, air
velocities and radiant long wave exchange
between the surface and the surroundings.
The EIC Visualizer calculates the actual
surface resistance coefficient during each timestep.
Table 6 Thermal bridges’ values determination

Roof windows
Façade windows

Ground
Below the lowest layer of construction, 0,5 m of
clay is included as a slap on ground
construction. Below the layer of clay, the
ground temperature is determined based on
ISO 13370.
Thermal bridges
To include thermal bridges joints between
walls, ceiling and floor are handled by using
exterior surface area (meaning that corners are
included twice).
The thermal bridge related to the joint between
window and building envelope (roof/wall) is
treated differently for façade windows and roof
windows.

, connection between window and building envelope
 = 0,000174 * tinsulation + 0,0399 W/mK
where the unit of tinsulation is in mm
0,05 W/mK
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Internal walls
The thermal mass of internal partition walls is
included in all EIC Visualizer models. The area
of internal partition walls depends on the
geometry of the house. For all houses, the
same length of internal wall in relation to the
floor area is used. This number is 0,32 m of
wall per m² of house.

Table 8 Leakiness values

Construction
period
Leaky 1950
Average 1950
Airtight 1950
Leaky 1980
Average 1980
Airtight 1980
Leaky 1995
Average 1995
Airtight 1995
Leaky 2005
Average 2005
Airtight 2005
Passivhaus

The corresponding area of internal partition
walls is then calculated for each house type,
considering the actual floor area and the
average ceiling height.
Table 7 Internal walls areas

Size type
1-storey house,
flat ceiling
1-storey house,
open ceiling
1½-storey single
family house
Roof space (on
top of building)

Leakiness at 50 Pa
[ACH]
20
13
6
10
6
2
6
4
1
4
2
1
0,6

m² internal walls
A
B

C

77,7

114,2

139,6

103,1

156,8

191,7

cp-values for house types

98,5

134,5

161,4

86,7

120,7

159,1

The cp-value used for the ventilation
calculations are the same for all house types
and sizes. The values are taken from the AIVC
report TN 44 and apply to low-rise buildings
with a length:width ratio of 2:1 and surrounded
by buildings of similar height. The values are
seen in the table below.

The internal walls are assumed to be of 75 mm
lightweight concrete.
Roof space of model for 1-storey
building with horizontal ceiling

Rear

The roof space is not considered in the
simulation. This is a simplification as the roof
space will function as a thermal zone, but the
effect is assumed to be neglectable in most
cases.

Right

Left
Front

Leakiness
The table below is showing the leakiness
rates, which are used in the EIC Visualizer.
The data is taken from EN 13465 table A.2,
which is based on data from Sweden.

Wind angle

Table 9 Wind angle values

Face
Facade, front
Facade, rear
Facade, left
Facade, right
Roof front, pitch 25°
Roof rear, pitch 25°
Roof front, pitch 45°
Roof rear, pitch 45°

Wind angle
0
45
0,06
-0,12
-0,3
-0,38
-0,3
0,15
-0,3
-0,32
-0,49
-0,46
-0,4
-0,46
0,06
-0,15
-0,42
-0,6

90
-0,2
-0,2
0,18
-0,2
-0,41
-0,41
-0,23
-0,23

135
-0,38
-0,12
0,15
-0,32
-0,46
-0,46
-0,6
-0,15

180
-0,3
0,06
-0,3
-0,3
-0,4
-0,49
-0,42
-0,06

225
-0,38
-0,12
-0,32
0,15
-0,46
-0,46
-0,6
-0,15

270
-0,2
-0,2
-0,2
0,18
-0,41
-0,41
-0,23
-0,23

315
-0,12
-0,38
-0,32
0,15
-0,46
-0,46
-0,15
-0,6

360
0,06
-0,3
-0,3
-0,3
-0,49
-0,4
0,06
-0,42
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Windows and doors

Figure 39 Constructions tab

Here windows and doors are added and
edited. When you add or change a value, the
3D model is updated to reflect the change and
show the window or door.



Thermal properties of windows



The thermal properties for windows take the
actual slope and glass area into account, as
well as the effect of accessories on both
thermal resistance and g-value.
The U-value of the window is calculated based
on:





The window size, i.e. glass
percentage
The U-value and width of top, side
and bottom parts of the frame. The
U-value of the frame depends on the
window type.
The linear transmission coefficient for
the connection between pane and
frame (psi-value). A psi-value per
pane is used.





Angle-dependent pane U-values are
used for each pane.
g-, v- and e-values are used for
each pane.
For each solar shading accessory, a
multiplier for the g-value and a
multiplier for the -value are defined
for each pane.
For each solar shading accessory, a
value is defined for each pane which
should be subtracted from the Uvalue of the pane.

For the 1-storey house with flat ceiling, a light
shaft connects the roof window with the house.
The thermal resistance of the shaft walls is
considered to be equal to that of the roof
construction. The area of the shaft multiplied
by the U-value of the shaft is treated as a
thermal bridge in the calculation.
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Custom Pane
If needed the user can type in values for a
custom pane. The needed values are:
g-value The thermal transmittance of the glass
tv
glass

The light transmittance of the

te

The solar direct transmittance

psi
and glass unit

The linear loss between frame





1

  Af  Uf  l * 
Ag 
 1

 Ug  Rg 


Uw 
Aw
Solar shading devices for the custom pane can
also be edited. The needed parameters are:

Uglass for different slopes with a step of 5°.
The U-value should be declared for the glazing
alone. The total U-value of the window is
dependent on the size of the window.

Fc – Solar shading ratio (Fc = g system/ g
pane)

Based on the numbers the U-value is
calculated according to EQUATION.

dUg – U-value reduction

Ft – Solar shading visual ratio (Ft = t system/ t
pane)

Figure 40 Constructions tab
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The ventilation flap of roof windows is treated
Figure 41 Constructions tab

Ventilation properties of windows
For both roof windows and façade windows, a
maximum opening area is calculated for each
window size. The opening area is defined as:






Pivoting roof windows: based on 22
cm from bottom of frame to bottom
of sash, corresponding to a fully
opened VELUX Integra window.
Top-hung roof windows: based on
30° between frame and sash.
Openable façade windows: based on
20° between frame and sash.
Openable façade windows higher
than 2 metres: based on 10°
between frame and sash.

separately. The airflow rate depends on the
width of the window and the pressure
difference across the window. The airflow rate
is defined as:

qv  3.70  width  0.126  dp0.53

Where:




Width [m]
dP [Pa]
qv [l/s]
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Figure 42 Constructions tab
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Heating and cooling

Figure 42 Constructions tab

At this tab the controls for heating, cooling and
solar shading are selected, as well as the
schedule for the occupants of the house.
Occupants
The clothing insulation (clo) of occupants
varies throughout the year based on a
proportional control: When the PMV is lower
than -1, the people will wear maximum clothes
and when the PMV is higher than 1, the people
will wear the minimum amount of clothes. Clo
will vary as 0,85±0,25 and cannot be changed
be the user.
Advanced Shedule settings
In the advanced Schedule settings, you can
create additional rules for the occupancy
schedule by simply clicking the “Add” button.
The rule that you have just created appears in
the Rules window. Beneath you can set the
Daily schedule for it, which appears in a form
of timeline, similar to that in the basic schedule
settings for weekdays and weekends. Next you
can choose the starting and ending date for
the rule, using the calendar and select the

days of the week when the rule is valid (e.g.
01.07 – 31.08 on Wednesdays, Thursdays and
Fridays). After the rule is defined you can
describe it and save.
The advanced schedule settings can be used
when there is a time during the year, when
occupancy significantly differs from a ‘normal’
schedule. It can be for instance during the
holidays, when adults are not going to work
and children are going on a summer camp and
so on.
Electrical lighting
The electricity demand for electrical lighting is
determined based on the amount of daylight
entering the building as an average of the lux
level on a working plane.
The daylight model calculates the target
position of the direct light beam from each
window. Each surface that is hit will then reflect
diffusely. A radiosity model is applied to
negotiate diffuse light exchange according to
approximate view factors.
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The default values for installed power for
electric light include the effect of light fixtures.
The table below shows the values used in EIC
Visualizer. A linear function is used to
determine the power consumption when the
daylight level is between 0 lux and the given
set point.
The installed power in W/m² for 3 types of
light bulbs and 3 set points based on
average light fixtures

Table 10 Light levels dependance on installed lighting
power

Set point
Incandescent
(7,2 lm/W)
Fluorescent
(44 lm/W)
Mixed
(26 lm/W)

100 lux

50 lux

25 lux

13,9

6,9

3,5

2,3

1,1

0,6

8,1

4,0

2,0

Figure 43 Constructions tab
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Ventilation

Figure 43 Constructions tab

At this tab the controls for lighting and
ventilation are selected.
Airflow model
The airflow model used in the EIC Visualizer is
a pressure driven model. Cracks in the building
façade and windows are defined with regard to
airflow characteristics. The result is a
calculation of airflow that considers infiltration
through the façade and controlled natural
ventilation through windows as one, i.e. these
two components constitute the airflow and thus
the ventilation rate of the building.

The leakiness of the building is defined as the
the leakiness of a building pressurized at 50
Pa with the leakage equally distributed on the
facades. Windows are defined with a maximum
openable area, and the opening is modulated
up to this area according to the control options
selected.
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Results

Figure 43 Constructions tab

At this tab results are selected and viewed.
A note about timesteps in VELUX EIC viz.
The simulation engine uses a variable
timestep integration scheme and in
conjunction with weather input files with
fixed hourly timesteps and printed EIC
reports (also with fixed hourly timesteps
but for the preceeding hour) seemingly
strange results can occur. The figure
below represents a single problem
variable, say the outdoor air temperature in
various possible representations. (The
location of timesteps and shape of solution
curve is not quite realistic but that is of
minor consequence here.)

39/40

All weather data files (input as well as output)
are interpreted as containing instantaneous
values of a variable, i.e. no integration over a
certain time period is done or assumed. When
the PRN-file happens to be generated from
measured weather data, which usually
represents mean values over some period, the
given value should be the average around the
current time point.
However, in the results post processing in IDA
ICE, the values are presented as the average
over the preceeding hour. In a case such as in
the example above this can lead to quite
different results. The existence of this different
convention in the same environment may be
unfortunate but it is an artifact of other
considerations which are not fully presented
here (c.f. average of a month, a week or a
day). The hour between time 0 and 1 is called
1, just like the first month of the year is called
January.

For users that have a need to compare results
as accurately as possible, IDA Solver can
interpolate results to an arbitrary equidistant
timestep. To access this feature from ICE 3.0,
select a suitable Time step for output on the
Advanced tab of the Simulation Data dialog. All
generated .prn files will then have the
requested, fixed timestep. Equidistant data is
useful for results comparison in program such
as Excel and Matlab.
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